DTP CrossPoint 84 IPCP
Scaling Presentation Matrix Switchers with DTP Extension
**Safety Instructions • English**

**WARNING:** This symbol, ☑, when used on the product, is intended to alert the user of the presence of uninsulated dangerous voltages within the product's enclosure that may present a risk of electric shock.

**ATTENTION:** This symbol, ☑, when used on the product, is intended to alert the user of important operating and maintenance (servicing) instructions in the literature provided with the equipment.


**Instructions de sécurité • Français**

**AVIS CONCERNANT:** Ce pictogramme, ☑, lorsqu’il est utilisé sur le produit, signale à l’utilisateur la présence à l’intérieur de celui-ci de tensions dangereuses non-isolées susceptibles de provoquer un choc électrique.

**ATTENTION:** Ce pictogramme, ☑, lorsqu’il est utilisé sur le produit, signale à l’utilisateur des instructions d’utilisation ou de maintenance importantes qui se trouvent dans la documentation fournie avec le matériel.

**AVERTISSEMENT:** Ce pictogramme, ☑, lorsqu’il est utilisé sur le produit, signale à l’utilisateur la présence à l’intérieur de celui-ci de tensions dangereuses non-isolées susceptibles de provoquer un choc électrique.

**Chinese Simplified (简体中文)**

警告: 产品上的这个标志旨在警告用户该产品机壳内有暴露的危险电压，有触电危险。

注意: 产品上的这个标志旨在向用户设备使用的用户手册中有重要的操作和维修信息，阅读手册。

关于我们的产品安全指南、遵循的规范、EMI/EMF的兼容性、无障碍使用的指导等信息，您可参阅 Extron 网站 www.extron.com，参见 Extron 安全及遵守指南，产品编号 68-290-01。

**Chinese Traditional (繁體中文)**

警告: 此標誌 ☑，於產品上顯示者，是要提醒使用者，裝置機殼內可能有未絕緣的危險電壓，可造成觸電。

注意: 本產品標示此標誌者的使用者，請參考隨附的用戶手冊中重要的操作和維護(維修)說明。

有關安全性指導方針、法規遵守、EMI/EMF 兼容性、存取範圍和相關主題的詳細資訊，請參閱 Extron 網站 www.extron.com，然後參閱 Extron 安全及法規遵守手冊（手冊編號 68-290-01）。

**Japanese**

警告: この記号 ☑が製品上に表示されている場合は、装置内に絶縁されていない高電圧が流れ、感電の危険があることを示しています。

注意: この記号 ☑が製品上に表示されている場合は、本機の箱側脱着部品に接続されていない高電圧が流れ、感電の危険があることを示しています。

安全上のご注意、法規厳守、EMI/EMF 兼容性、その他の関連項目については、エクストロンウェブサイト www.extron.com または Extron 安全及び規制遵守ガイド（P/N 68-290-01）をご覧ください。

**Korean**

경고: 이 기호 ☑가 제품에 표시된 경우, 제품의 임의 분리나 제거는 하지 말고 주의해야 하는 취급에 관한 경고문과 함께 제품 안내서에 감지된 위험사항을 읽고 경고문과 함께 주의해야 합니다。

주의: 이 기호 ☑가 제품에 표시된 경우, 제품의 임의 분리나 제거는 하지 말고 주의해야 하는 취급에 관한 경고문과 함께 제품 안내서에 감지된 위험사항을 읽고 경고문과 함께 주의해야 합니다。

안전 기호와 심볼, 제품 안전, 제품 안전, 품질성, 그리고 품질성 품질에 대한 자세한 내용은 Extron 웹 사이트 www.extron.com의 Extron 안전 및 제품 준수 안내서 68-290-01과 조합도 참조하십시오。

**FCC Class A Notice**

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC rules. The Class A limits provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause interference; the user must correct the interference at his own expense.

**ATTENTION:** The Twisted Pair Extension technology works with unsheathed twisted pair (UTP) or shielded twisted pair (STP) cables; but, to ensure FCC Class A and CE compliance, STP cables and STP Connectors are required.

For more information on safety guidelines, regulatory compliances, EMI/EMF compatibility, accessibility, and related topics, see the “Extron Safety and Regulatory Compliance Guide” on the Extron website.

**Copyright**

© 2014 Extron Electronics. All rights reserved

**Trademarks**

All trademarks mentioned in this guide are the properties of their respective owners.

The following registered trademarks®, registered service marks™, and trademarks™ are the property of RGB Systems, Inc. or Extron Electronics:

**Registered Trademarks®**

AVTrac, Cable Cubby, CrossPoint, eBUS, EDID Manager, EDID Minder, EQIP, Extron, Flat Field, GlobalViewer, Hideaway, Inline, IP Intercom, IP Link, Key Minder, Lockit, MediaLink, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, SoundField, SpeedMount, SpeedSwitch, System INTEGRATOR, TeamWork, TouchLink, V-Lock, VersaTools, VN-Matrix, VoiceLift, WallVault, WindoWall, XTP, and XTP Systems

**Registered Service Mark™:** S3 Service Support Solutions

**Trademarks™**

AAP, AFL (AccuRate Frame Lock), ADSP (Advanced Digital Sync Processing), Auto-Image, CableCover, CRDS (Class B Ripple Suppression), DSDS (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP (Digital Sync Validation Processing), FastBite, FONBOX, IP Intercom HelpDesk, LinkLicense, MAAP, MoniDigital, ProDSF, Q5 FPC (QuickSwitch Front Panel Controller), ScopeTrig, SIS, Simple Instruction Set, Shave-Free, SpeedNav, Triple-Action Switching, XTRA, ZipCaddy, ZipClip
Conventions Used in this Guide

Notifications
The following are used:

**ATTENTION:**
- Risk of property damage.
- Risque de dommages matériels.

**NOTE:** A note draws attention to important information.

Software Commands

Commands are written in the fonts shown here:

```
^AR Merge Scene,,Op1 scene 1,1 "B51 "W"C
[01] R0004 00300 00400 00800 00600 [02] 35 [17] [03]
```

**NOTE:** For commands and examples of computer or device responses mentioned in this guide, the character “0” is used for the number zero and “O” is the capital letter “o.”

Computer responses and directory paths that do not have variables are written in the font shown here:

```
Reply from 208.132.180.48: bytes=32 times=2ms TTL=32
C:\Program Files\Extron
```

Variables are written in slanted form as shown here:

```
ping xxx.xxx.xxx.xxx -t
```

Selectable items, such as menu names, menu options, buttons, tabs, and field names are written in the font shown here:

```
From the File menu, select New.
```

Specifications Availability


Contents

**Introduction** ..............................................1
- About this Guide .................................1
- About the DTP CrossPoint Matrix Switchers ..............................................1
- DTP Input and Output Signals ......3

**Installation** ...........................................4
- Rear Panel ........................................4
- Video Inputs and Outputs .............5
- Audio Inputs and Outputs ............7
- Serial and IR Insertion Connections ..............................................8
- Control Connections .......................8
- Switcher Reset .................................8
- Power .............................................9
- Additional Connector Information ..............................................9
- Front Panel ....................................14

**Remote Control** .......................................19
- Selected SIS Commands .................19
- Establishing a Network (Ethernet) Connection ..............................................19
- Number of Connections ................20
- Establishing a USB Port Connection ..............................................20
- Host-to-Switcher Instructions 20
- Common SIS Command Symbols 20
- SIS Command and Response Table for Matrix Switcher Commands ..............................................21
- Installing the programs ................21
- Starting the Product Configuration Software ..............................................26
- Starting the DSP Configurator Program ..............................................28
- Accessing the HTML Pages ........30

**Front Panel Operations** ..........................15
- Creating a Tie ....................................15
- Recalling a Preset .............................16
- Viewing Ties (and Muting Outputs) ................16
- Viewing and Adjusting Volume and Mic Volume ..............................................16
- Setting the Front Panel Locks (Executive Modes) ..............................................17
- Selecting Lock Mode 2 or Toggling Between Mode 2 and Mode 0 ..............................................17
- Selecting Lock Mode 2 or Toggling Between Mode 2 and Mode 1 ..............................................18
Introduction

This section gives an overview of the Extron DTP CrossPoint 84 IPCP Series matrix switchers and describes their features. Topics that are covered include:

• About this Guide
• About the DTP CrossPoint Matrix Switchers

About this Guide


This guide provides instructions for an experienced installer to set up and operate the Extron DTP CrossPoint 84 IPCP Scaling Presentation Matrix Switchers with DTP Extension. Step by step instructions show you how to:

• Connect the hardware
• Perform basic operations
• Use both the front panel controls and selected Simple Instruction Set (SIS) commands
• Load and start up the Microsoft® Windows®-based Product Configuration Software and DSP Configurator Program.
• Connect to the built-in HTML pages, which you can use to view the switcher status and make changes to the communications protocol and set the system clock.

About the DTP CrossPoint Matrix Switchers

The DTP CrossPoint matrix switchers distribute HDCP-compliant HDMI and Extron proprietary DTP video and audio signal types. A matrix switcher routes any input signal to any combination of outputs. It can route multiple input and output configurations simultaneously.

The fixed matrix size switchers support a total of eight inputs: six HDMI and two inputs from Extron DTP transmitting devices. The matrix switchers provide four outputs: two HDMI and two scaled DTP outputs.

The DTP CrossPoint Matrix Series consists of two 8-input by 4-output models, differentiated by their audio capabilities:

DTP CrossPoint 84 IPCP SA — Includes a stereo audio amplifier
DTP CrossPoint 84 IPCP MA 70 — Includes a 70 V mono audio amplifier
**DTP Input and Output Signals**

The DTP inputs and outputs are proprietary signals that are created within any of the Extron DTP Extenders systems and transmitted over a single shielded twisted pair (STP) cable.

The DTP CrossPoint accepts DTP inputs from transmitting devices such as the DTP T USW 333. Depending on the connected transmitting model, it generates the DTP signal from a variety of video and audio inputs, including HDMI, DVI, analog VGA, and embedded and analog audio. The DTP signal can also include bidirectional RS-232 and IR control signals from the connected transmitting and receiving devices or inserted locally, on the DTP CrossPoint switcher.

Depending on the technology of the transmitting or receiving device, DTP 330 or DTP 230, the TP inputs and outputs can travel up to 330 feet (100 meters) or 230 feet (70 meters) without a loss of signal integrity.

---

**Figure 1. Typical DTP CrossPoint Application**

The switchers provide four mono microphone (mic)/line level inputs that can be mixed with or across one or all audio outputs.

The switcher also features the built-in Extron IPCP Pro 350 control processor, which has local area network (LAN) Ethernet ports, RS-232 and IR-based control, relays, and digital I/O controls that can control and monitor a variety of external devices, such as projectors and lights.

The matrix switcher can be remotely controlled via Ethernet LAN ports on the IPCP control processor, a serial port, or a USB port connection using either the Extron Product Configuration Software, DSP Configurator software, or the Simple Instruction Set (SiS).
Installation

This section describes installation of the DTP CrossPoint matrix switchers, including connections and features. Topics that are covered include:

- Rear Panel
- Front Panel

Rear Panel

Figure 2. DTP CrossPoint 84 IPCP SA Switcher Rear Panel

ATTENTION:
- Remove system power before making all connections.
- Débranchez l'alimentation du système avant de faire n'importe quelle connexion.

NOTE: L, below, is on the mono audio versions of the switcher and is shown on figure 5, on page 7. It is in the same location on the switcher as K, in figure 2.

Video Inputs and Outputs

- **HDMI Inputs 1 through 6** — Plug HDMI digital video (or DVI with appropriate adapters) into these HDMI ports. See **HDMI connectors** on page 9 to secure the connector to the board with a LockIt HDMI Cable Lacing Bracket.
- **TP (XTP/DTP) switches, inputs 7 and 8** —

  ATTENTION:
  - Position this switch **BEFORE** connecting the appropriate device to the TP connector. Failure to comply can damage the endpoint.
  - Positionnez le sélecteur **AVANT** de connecter l’appareil approprié au connecteur TP. Ne pas respecter cette procédure pourrait endommager le point de connexion.

  XTP position — Select if the transmitting device is an Extron XTP matrix switcher. The input is HDMI with embedded audio plus RS-232 and IR.

  DTP position — Select if the transmitting device is an Extron DTP device. The input is HDMI with embedded audio, analog audio, RS-232 and IR, and remote power.

- **TP Inputs 7 and 8** — Plug compatible Extron DTP or XTP signals into these RJ-45 ports using STP cables. See **TP connectors** on page 10 to wire the connectors.

ATTENTION:
- Do not connect this port to a computer data or telecommunications network.
- Ne connectez pas ces port à des données informatiques ou à un réseau de télécommunications.
Figure 3. Video Output Features

D HDMI Output 1 and 2 — Plug HDMI video displays (or DVI with appropriate adapters) into these ports. See HDMI connectors on page 9 to secure the connector to the board with a Lockit HDMI Cable Lacing Bracket.

E TP (XTP/HDBT/DTP switches, outputs 3 and 4 —

**ATTENTION:**
- Position this switch **BEFORE** connecting the appropriate device to the TP connector. Failure to comply can damage the endpoint.
- Positionnez le sélecteur **AVANT** de connecter l’appareil approprié au connecteur TP. Ne pas respecter cette procédure pourrait endommager le point de connexion.

XTP position — Select if the receiving device is an Extron XTP matrix switcher. The output is HDMI with embedded audio plus IR.

HDBT position — Select if the receiving device is a HDBaseT-enabled device. The output is HDMI with embedded audio plus RS-232 and IR.

DTP position — Select if the receiving device is an Extron DTP device. The TP output is compatible with a DTP receiving device and consists of HDMI with embedded audio, analog audio, RS-232 and IR, and remote power.

F TP Outputs 3 and 4 — Plug compatible Extron DTP receivers, XTP matrix switchers, or HDBaseT-enabled devices into these RJ-45 ports using STP cables. See TP connectors on page 10 to wire the connector.

**ATTENTION:**
- Do not connect this port to a computer data or telecommunications network.
- Ne connectez pas ces port à des données informatiques ou à un réseau de télécommunications.

Audio Inputs and Outputs

Audio Inputs 1 through 6 — Plug balanced or unbalanced stereo audio inputs into these 3.5 mm, 5-pole captive screw connectors (see Local and Mic/line audio connectors on page 13 to wire the connectors).

Mic/Line Inputs 1 through 4 — Plug microphones or other mono audio inputs into these 3-pole, 3.5 mm captive screw connectors (see Local and Mic/line audio connectors on page 13 to wire the connectors).

+48 V (phantom power) LEDs — Light to indicate +48 V phantom power is switched on via software.

Audio Outputs 1 through 4 — Plug audio devices such as an audio amplifier or powered speakers to these 3.5 mm, 5-pole captive screw connectors (see Local and Mic/line audio connectors on page 13 to wire the connectors).

Amp Output 1 (stereo audio model) — Plug passive, 4-ohm or 8-ohm speakers to this 5 mm 4-pole captive screw connector to receive the amplified audio from output 1.

Amp Output 1 (mono audio model, see figure 5) — Connect passive, speakers to this 2-pole captive screw connector to receive the amplified audio from output 1.

S/PDIF Output 4 — Plug a compatible device into this RCA connector with a 75-ohm digital audio cable to receive digital audio signal from the output 4 digital stream.

DMP Expansion Port and LED —
- Expansion Port — Plug an STP cable between this port and the Expansion port on an optional Extron DMP 128 ProDSP Digital Matrix Processor.
- Link LED — Lights to indicate that the port is connected to a compatible device.
Serial and IR Insertion Connections

Figure 6. Serial and IR Insertion Connections

- **Over TP (Inputs 7 and 8) Ports** — Plug serial RS-232 signals, modulated IR signals, or both into these 3.5 mm, 5-pole captive screw connectors to insert bidirectional RS-232 and IR communications. See RS-232 and IR connectors on page 13 to wire the connectors.

- **Over TP (Outputs 3 and 4) Ports** — Plug serial RS-232 signals, modulated IR signals, or both into these 3.5 mm, 5-pole captive screw connectors to insert bidirectional RS-232 and IR communications. See RS-232 and IR connectors on page 13 to wire the connectors.

Control Connections

Figure 7. IPCP Control Processor and Remote Port

- **IPCP control processor** — The DTP CrossPoint 84 includes a built-in IPCP control processor that can control and monitor a variety of external devices. The IPCP offers RS-232 and IR-based control, relays, and digital I/O controls. See the IPCP Pro Series Setup Guide, included in the carton with the switcher to make all connections and to configure and operate the IPCP control processor.

- **Remote Port** — Plug a serial RS-232 device into the matrix switcher via this 3.5 mm, 3-pole captive screw connector for remote control of the switcher (see RS-232 and IR connectors on page 13 to wire the connector).

Switcher Reset

- **Switcher Reset button and LED** — Initiates four levels of matrix switcher reset. For different reset levels, press and hold the recessed button while the switcher is running or while you power up the switcher.


Power

- **Power connector** — Plug the switcher into a grounded AC source.

Additional Connector Information

HDMI connectors

Use a LockIt Lacing Bracket to securely fasten each HDMI cable to the switcher as follows.

1. Plug the HDMI cable into the panel connection.

2. Loosen the HDMI connection mounting screw from the panel enough to allow the LockIt lacing bracket to be placed over it. The screw does not have to be removed.

3. Place the LockIt lacing bracket on the screw and against the HDMI connector, then tighten the screw to secure the bracket.

**ATTENTION:**
- Do not overtighten the HDMI connector mounting screw. The shield it fastens to is very thin and can easily be stripped.
- Ne serrez pas trop la vis de montage du connecteur HDMI. Le blindage auquel elle est attachée est très fin et peut facilement être dénudé

4. Loosely place the included tie wrap around the HDMI connector and the LockIt lacing bracket as shown.

5. While holding the connector securely against the lacing bracket, use pliers or similar tool to tighten the tie wrap, then remove any excess length.
TP connectors

All RJ-45 ports, whether DTP ports, the Expansion port, and the LAN (Ethernet) ports on the IPCP control processor use twisted pair cables (see figure 8).

- **Patch (straight) cable** —
  - **DTP input and output ports** — Shielded twisted pair (STP) for connection to Extron DTP transmitters and receivers, XTP matrix switches, or HDBaseT-enabled devices.
  - **Expansion port** — STP for connection between the matrix switcher and a DMP 128. A shielded 1-foot cable is included with the DMP 128.
  - **LAN ports** — Unshielded twisted pair (UTP) or STP for connection of the LAN port to an Ethernet LAN.

- **Crossover cable** (see figure 8) —
  - **LAN ports** — UTP or STP for direct connection between the DTP CrossPoint 84 matrix switcher and a connected computer.

<table>
<thead>
<tr>
<th>Straight-through Cable</th>
<th>Crossover Cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>DTP I/O Ports, Expansion Port, and LAN Ports</td>
<td>LAN Ports</td>
</tr>
<tr>
<td>Pin</td>
<td>End 1 Wire color</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>White-orange</td>
</tr>
<tr>
<td>2</td>
<td>Orange</td>
</tr>
<tr>
<td>3</td>
<td>White-green</td>
</tr>
<tr>
<td>4</td>
<td>Blue</td>
</tr>
<tr>
<td>5</td>
<td>White-blue</td>
</tr>
<tr>
<td>6</td>
<td>Green</td>
</tr>
<tr>
<td>7</td>
<td>White-brown</td>
</tr>
<tr>
<td>8</td>
<td>Brown</td>
</tr>
</tbody>
</table>

A cable that is wired the same at both ends is called a "straight-through" cable, because no pin/pair assignments are swapped.

<table>
<thead>
<tr>
<th>T568B</th>
<th>T568A</th>
<th>T568B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>White-green</td>
<td>White-orange</td>
</tr>
<tr>
<td>2</td>
<td>Green</td>
<td>Orange</td>
</tr>
<tr>
<td>3</td>
<td>White-orange</td>
<td>White-green</td>
</tr>
<tr>
<td>4</td>
<td>Blue</td>
<td>Blue</td>
</tr>
<tr>
<td>5</td>
<td>White-blue</td>
<td>White-blue</td>
</tr>
<tr>
<td>6</td>
<td>Orange</td>
<td>Green</td>
</tr>
<tr>
<td>7</td>
<td>White-brown</td>
<td>White-brown</td>
</tr>
<tr>
<td>8</td>
<td>Brown</td>
<td>Brown</td>
</tr>
</tbody>
</table>

A cable that is wired as T568A at one end and T568B at the other (Tx and Rx pairs reversed) is a "crossover" cable.

**NOTES:**

- Do not use standard telephone cables. Telephone cables do not support Ethernet or Fast Ethernet.
- Do not stretch or bend cables. Transmission errors can occur.

LAN ports

The LAN ports require Category (CAT) 3, CAT 5e, or CAT 6a unshielded twisted pair (UTP) or shielded twisted pair (STP) cables, crossover or patch cables.

The cable used depends on your network speed. The switcher LAN port supports both 10 Mbps (10Base-T — Ethernet) and 100 Mbps (100Base-T — Fast Ethernet), half-duplex and full-duplex Ethernet connections. Input and output boards support 100Base-T only.

- 10Base-T Ethernet requires CAT 3 UTP or STP cable at minimum.
- 100Base-T Fast Ethernet requires CAT 5e UTP or STP cable at minimum.

See the IPCP Pro Series User Guide at [www.extron.com](http://www.extron.com) to make all network connections and to configure and operate the IPCP control processor.

DTP and Expansion ports

The DTP input and output ports are compatible with Extron XTP DTP 24 SF/UTP cables, as well as CAT 5e, 6, 6a, and 7 shielded twisted pair (F/UTP, SF/UTP, and S/FTP) cable. The Expansion port requires CAT 5e, 6, 6a, or 7 shielded twisted pair cable.

For the Expansion port only —

**ATTENTION:**

- Connect this port to the Expansion port on a compatible Extron DMP processor. Do **NOT** connect this port to a LAN or Power over Ethernet port; equipment damage can occur.
- Connectez ce port au port d’expansion sur un processeur DMP d’Extron compatible. Ne connectez **PAS** ce port à un port LAN ou d’alimentation via Ethernet ; le matériel pourrait être endommagé.
For the DTP ports only —

Extron recommends the following practices to achieve full transmission distances up to 330 feet (100 m) and reduce transmission errors.

Use the following Extron XTP DTP 24 SF/UTP cables and connectors for the best performance:

- **XTP DTP 24/1000** Non-Plenum 1000’ (305 m) spool 22-236-03
- **XTP DTP 24P/1000** Plenum 1000’ (305 m) spool 22-235-03
- **XTP DTP 24 Plug** Package of 10 101-005-02

If not using XTP DTP 24 cable, at a minimum, Extron recommends 24 AWG, solid conductor, STP cable with a minimum bandwidth of 400 MHz.

Terminate cables with shielded connectors to the TIA/EIA T568B standard only (patch cables, see figure 8 on page 10).

Limit the use of more than two pass-through points, which may include patch points, punch down connectors, couplers, and power injectors. If these pass-through points are required, use CAT 6 or 6a shielded couplers and punch down connectors.

**ATTENTION:**
- Do not connect these boards to a computer data or telecommunications network.
- Ne connectez pas ces port à des données informatiques ou à un réseau de télécommunications.
- Do not use Extron UTP23SF-4 Enhanced Skew-Free AV UTP cable or STP201 cable to link the matrix switcher to Extron DTP or XTP products or HDBaseT-enabled devices.
- N’utilisez pas le câble AV Skew-Free UTP version améliorée UTP23SF d’Extron ou le câble STP201 pour relier la grille de commutation avec des produits XTP ou DTP d'Extron, ou des appareils équipés HDBaseT.
- To ensure FCC Class A and CE compliance, STP cables and STP connectors are required.
- Afin de s’assurer de la compatibilité entre FCC Classe A et CE, les câbles STP et les connecteurs STP sont nécessaires.

**NOTE:** When using cable in bundles or conduits, consider the following:
- Do not exceed 40% fill capacity in conduits.
- Do not comb the cable for the first 20 meters, where cables are straightened, aligned, and secured in tight bundles.
- Loosely place cables and limit the use of tie wraps or hook and loop fasteners.
- Separate twisted pair cables from AC power cables.

**ATTENTION:**
- For unbalanced audio output, connect the sleeves to the ground contact. **DO NOT** connect the sleeves to the negative (–) contacts.
- Pour l’audio asymétrique, connectez les manchons au contact au sol. **Ne PAS** connecter les manchons aux contacts négatifs (–).

**NOTES:**
- The length of exposed wires is important. The ideal length is 3/16 inch (5 mm).
- If the stripped section of wire is longer than 3/16 inch, the exposed wires may touch, causing a short circuit.
- If the stripped section of wire is shorter than 3/16 inch, wires can be easily pulled out even if tightly fastened.
- Do not tin the power supply leads. Tinned wires are not as secure in the connector and could be pulled out.

**RS-232 and IR connectors**

Figure 10 shows how to wire the RS-232 and IR connector.

**NOTE:** The length of exposed wires is important (see the audio connectors **NOTES** above for more information).
Creating a Tie

1. Press and release the Esc button to clear any input button, output button, or control button indicators that may be lit.
2. Press and release the Video and Audio I/O buttons to select or deselect video, audio, or both as desired.
3. Press and release the desired input button. The button lights to indicate the selection.
4. Press and release the desired output buttons. Amber indicates video and audio tie. Green indicates video only tie. Red indicates audio only tie.
5. Press and release the Enter button. All button indicators turn off.

NOTE: Audio or video can be broken away (tied by itself) by selecting only the Video button or only the Audio button.
Recalling a Preset

A "preset" is a configuration that has been stored.

1. Press and release the Preset button.

2. Press and release the desired input or output button.

The button blinks red to indicate that this preset is selected to save or recall.

3. Press and release the Enter button.

Viewing Ties (and Muting Outputs)

1. Press the View button. Output buttons light for outputs that have no ties established.

   NOTE: If an output button blinks, the output indicated by that button is muted. If only the Video or Audio button is lit, only the video or HDMI audio is muted. To toggle mute on and off, press and hold the output button for 2 seconds.

2. Press an input button. The buttons for all tied outputs light.

3. Press an output button. The buttons for the tied input and all tied outputs light.

4. Press the View button again to exit View mode. All input and output buttons return to an unlit state.

Viewing and Adjusting Volume and Mic Volume

Rotate the applicable knob clockwise to increase the program volume or mic volume. Rotate the knob counterclockwise to decrease volume.

The LED ladder indicates the approximate volume; the more LEDs are lit, the higher the volume.

Setting the Front Panel Locks (Executive Modes)

The matrix switcher has three levels of front panel security lock that limit the operation of the switcher from the front panel. The three levels are:

- **Lock mode 0** — The front panel is completely unlocked.
- **Lock mode 1** — All functions are locked from the front panel (except for setting Lock mode 2). Some functions can be viewed.
- **Lock mode 2** — Basic functions are unlocked. Advanced functions are locked and can be viewed only.

**Basic** functions consist of:
- Making ties
- Recalling presets
- Setting audio volume
- Changing Lock modes

**Advanced** functions consist of:
- Setting audio output mutes
- Setting front panel configuration

The switcher is shipped from the factory in Lock mode 2.

Selecting Lock Mode 2 or Toggling Between Mode 2 and Mode 0

NOTES:
- If the switcher is in Lock mode 0 or mode 1, this procedure selects mode 2. The Esc, Video, and Audio buttons flash twice.
- If the switcher is in Lock mode 2, this procedure selects mode 0 (unlocks the switcher). The Video and Audio buttons flash twice.

Toggle the lock on or off by pressing and holding the Enter, Video, and Audio buttons simultaneously until the buttons flash (approximately 2 seconds).
Remote Control

This section describes using the remote control features of the DTP CrossPoint matrix switchers to control the devices. Topics that are covered include:

- Selected SIS Commands
- Installing and Starting the Control Programs
- Accessing the HTML Pages

Selected SIS Commands

You can use Simple Instruction Set (SIS) commands for operation and configuration of the switchers (see SIS Command and Response Table for Matrix Switcher Commands on page 21). You can run these commands from a PC connected to an Ethernet port on the IPCP control processor (item Q on page 8), serial port (item R on page 8), or USB port (item A on page 14) on the switcher.

Establishing a Network (Ethernet) Connection

NOTE: The first time you connect to the switcher via the LAN port, you may need to change the default settings (IP address, subnet mask, and [optional] administrator name and password) of the controller.

Establish a network connection as follows:

1. Open a TCP socket to port 23 using the IP address of the switcher.

   NOTE: The factory default IP address is 192.168.254.254.

   The switcher responds with a copyright message including the name, firmware version, and part number of the product, and the current date and time.

   NOTES:
   - If the switcher is not password-protected, the device is now ready to accept SIS commands.
   - If the switcher is password-protected, a password prompt appears.

2. If necessary, enter the appropriate password.

   If the password is accepted, the switcher responds with Login User or Login Administrator.

   If the password is not accepted, the Password prompt reappears.
Number of Connections

A switcher can have up to 200 simultaneous TCP connections, including all HTTP sockets and Telnet connections. When the connection limit is reached, the switcher accepts no new connections until some have been closed. No error message or indication is given that the connection limit has been reached. To maximize the performance of your switcher, keep the number of connections low and close unnecessary open sockets.

Establishing a USB Port Connection

A standard USB cable and the Extron DataViewer utility, version 2.0 or newer, can be used for connection to the DTP CrossPoint matrix switcher Configuration port. The USB cable, available at any local electronics store, should be terminated on one end with a mini USB B male connector.

### NOTE:
Before you use the USB port for the first time, install the USB driver on your computer. The simplest way to do this is to install the Product Configuration Software and then run the Found New Hardware Wizard.

Host-to-Switcher Instructions

The switcher accepts SIS commands through its serial port, its USB port, or its LAN port. SIS commands consist of one or more characters per command field. They do not require any special characters to begin or end the command character sequence. Each switcher response to an SIS command ends with a carriage return and a line feed (CR/LF = \r\n), which signals the end of the response character string. A string is one or more characters.

### NOTE:
The tables that begin on the next page are a partial list of SIS commands. For a complete listing, see the DTP CrossPoint 84 IPCP Series User Guide.

Common SIS Command Symbols

The following symbols are used throughout the command and response table, which starts on the next page:

- = Space
- = Carriage return and line feed
- = Carriage return (no line feed)
- = Pipe (can be used interchangeably with the \| character)
- = Escape key (hex 1B)
- = Can be used interchangeably with the \| character

<table>
<thead>
<tr>
<th>Command</th>
<th>SIS Command (Host to Unit)</th>
<th>Additional Description</th>
<th>Response (Unit to Host)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create ties</td>
<td>7*5% Out05</td>
<td>Tie input 7 video to output 5.</td>
<td>7*5% In05</td>
</tr>
<tr>
<td>Video mutes</td>
<td>*0B Vmt0</td>
<td>Global video unmute</td>
<td>*0B In00</td>
</tr>
<tr>
<td>Audio breakaway</td>
<td>*1B Vmt</td>
<td>Video and sync mute</td>
<td>*1B Out00</td>
</tr>
<tr>
<td>Global video mute</td>
<td>1*B Vmt1</td>
<td>Mute all video outputs</td>
<td>1*B In00</td>
</tr>
<tr>
<td>Mute output</td>
<td>B2</td>
<td>Mute output 2 video and sync off.</td>
<td>B2 In00</td>
</tr>
<tr>
<td>Video only mute</td>
<td>1*1!</td>
<td>Video only mute</td>
<td>1*1 In00</td>
</tr>
</tbody>
</table>

### Table

<table>
<thead>
<tr>
<th>Command</th>
<th>SIS Command (Host to Unit)</th>
<th>Additional Description</th>
<th>Response (Unit to Host)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create ties</td>
<td>7*5% Out05</td>
<td>Tie input 7 video to output 5.</td>
<td>7*5% In05</td>
</tr>
<tr>
<td>Video mutes</td>
<td>*0B Vmt0</td>
<td>Global video unmute</td>
<td>*0B In00</td>
</tr>
<tr>
<td>Audio breakaway</td>
<td>*1B Vmt</td>
<td>Video and sync mute</td>
<td>*1B Out00</td>
</tr>
<tr>
<td>Global video mute</td>
<td>1*B Vmt1</td>
<td>Mute all video outputs</td>
<td>1*B In00</td>
</tr>
<tr>
<td>Mute output</td>
<td>B2</td>
<td>Mute output 2 video and sync off.</td>
<td>B2 In00</td>
</tr>
<tr>
<td>Video only mute</td>
<td>1*1!</td>
<td>Video only mute</td>
<td>1*1 In00</td>
</tr>
</tbody>
</table>

### NOTE:
- Input number is 00 – 08 (00 = untied)
- Output number is 00 – 08 (00 = Mute)
- 1 = video muted
- 2 = video and sync muted
- \| = Can be used interchangeably with the \| character
- = Input number
- = Output number
## SIS Command and Response Table for Matrix Switcher Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>SIS Command (Host to Unit)</th>
<th>Response (Unit to Host)</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create ties</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>NOTES:</strong></td>
<td>• Commands can be entered back-to-back in a string, with no spaces. For example: <code>1*1!02*02$03%4*4$</code>.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The matrix switchers support 1- and 2-digit numeric entries (1<em>1! or 02</em>02%).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Audio breakaway command functions are dependent on the audio routing selections of the inputs and outputs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tie input $X_1$ video and audio to output $X_2$</td>
<td>$X_1^*X_2!$</td>
<td>Out$X_2$•In$X_1$•All $\leftarrow$</td>
<td>Tie the video and audio from input $X_1$ to output $X_2$.</td>
</tr>
<tr>
<td>Example:</td>
<td>1*3!</td>
<td>Out$03$•In$01$•All $\leftarrow$</td>
<td>Tie input 1 to output 3.</td>
</tr>
<tr>
<td>Tie input $X_1$ to output $X_2$, video</td>
<td>$X_1^*X_2%$</td>
<td>Out$X_2$•In$X_1$•Vid $\leftarrow$</td>
<td>Tie input $X_1$ video to output $X_2$. Audio is broken away.</td>
</tr>
<tr>
<td>Example:</td>
<td>7*5%</td>
<td>Out$05$•In$07$•Vid $\leftarrow$</td>
<td>Tie input 7 video to output 5.</td>
</tr>
<tr>
<td>Tie input $X_1$ to output $X_2$, audio</td>
<td>$X_1^*X_2$</td>
<td>Out$X_2$•In$X_1$•Aud $\leftarrow$</td>
<td>Tie input $X_1$ audio to output $X_2$. Audio is broken away.</td>
</tr>
<tr>
<td>Example:</td>
<td>2*04$</td>
<td>Out$04$•In$02$•Aud $\leftarrow$</td>
<td>Tie input 2 audio to output 4.</td>
</tr>
<tr>
<td>Tie input $X_1$ to all outputs</td>
<td>$X_1^!$</td>
<td>In$X_1$•All $\leftarrow$</td>
<td>$X_1^!$ and $X_1^*$ are also valid.</td>
</tr>
<tr>
<td>Quick multiple tie</td>
<td>$Esc[0</td>
<td>X_1^*X_2!\ldots</td>
<td>X_1^*X_2$}</td>
</tr>
<tr>
<td>Read video output tie</td>
<td>$X_2%$</td>
<td>$X_1$ $\leftarrow$</td>
<td>Video input $X_1$ is tied to output $X_2$. $X_2$ is also valid for audio.</td>
</tr>
<tr>
<td><strong>Video mutes</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video only mute</td>
<td>$X_2^1B$</td>
<td>Vmt$X_2^1$ $\leftarrow$</td>
<td>Mute output $X_2$ video (sync remains active).</td>
</tr>
<tr>
<td>Video and sync mute</td>
<td>$X_2^2B$</td>
<td>Vmt$X_2^2$ $\leftarrow$</td>
<td>Mute output $X_2$ video and sync.</td>
</tr>
<tr>
<td>Video unmute</td>
<td>$X_2^0B$</td>
<td>Vmt$X_2^0$ $\leftarrow$</td>
<td>Unmute output $X_2$ (video and sync on).</td>
</tr>
<tr>
<td>Read video mute</td>
<td>$X_2B$</td>
<td>$X_3$ $\leftarrow$</td>
<td></td>
</tr>
<tr>
<td>Global video mute</td>
<td>1*B</td>
<td>Vmt1 $\leftarrow$</td>
<td>Mute all video outputs.</td>
</tr>
<tr>
<td>Global video unmute</td>
<td>0*B</td>
<td>Vmt0 $\leftarrow$</td>
<td>Unmute all video outputs.</td>
</tr>
</tbody>
</table>

**NOTE:** $X_1$ = Input number $00$ – $08$ ($00$ = untied) $X_2$ = Output number $01$ – $04$ $X_3$ = Mute $0$ = off (unmuted) $1$ = video muted $2$ = video and sync muted
### Command Setup

**HDCP status**
- View input HDCP status: `E0 018*HDCP` → `OD` → `KD`
- View output HDCP status: `E0 028*HDCP` → `OS` → `OK`
- View HDCP status of all outputs: `E0 038*HDCP` → `OS` → `OK`
- View HDCP status of all inputs: `E0 048*HDCP` → `OD` → `KD`

**Input reports as an HDCP-authorized device**
- HDCP authorized device on: `E0 058*HDCP` → `OD` → `KD`
- HDCP authorized device off: `E0 068*HDCP` → `OD` → `KD`
- Show HDCP authorized device status: `E0 078*HDCP` → `OD` → `KD`

**Execute Auto-Image**
- Execute Auto-Image: `E0 088*AFMT` → `OD` → `KD`

**List Digital Sync Validation Processing (DSVP)**
- List sync of all inputs: `E0 098LS` → `O0 108LS` → ... → `O8 178LS`
  - Example: `E0 LS` → `O0 LS` → ... → `O8 LS`

**Group master level (volume and mute)**

### Group master level

**Command**
- **Input audio selection**
  - Input audio selection: `E0 108*AFMT` → `OD` → `KD` → `KD`
  - Example: `E0 108*AFMT` → `OD` → `KD` → `KD`
  - View input audio selection: `E0 118AFMT` → `OD` → `KD` → `KD`
  - View input audio all selections: `E0 128AFMT` → `OD` → `KD` → `KD`

**Group master level**

**NOTES:**
- The DTP CrossPoint 84 has 16 configurable group masters.
- By factory default, group 1 controls the program volume and group 2 controls the mic volume.
- Other group masters (such as mutes) must have been created in the DSP Configurator program to be available as `XIBs` for SIS commands.

Set gain (+) or attenuation (−) dB value: `E0 118+50GRPM` → `OD` → `KD`
- Example: `E0 118+50GRPM` → `OD` → `KD`

Increment dB value: `E0 128+125GRPM` → `OD` → `KD` → `KD`
- Example: `E0 128+125GRPM` → `OD` → `KD` → `KD`

Decrement dB value: `E0 138-125GRPM` → `OD` → `KD` → `KD`
- Example: `E0 138-125GRPM` → `OD` → `KD` → `KD`

View master value: `E0 148GRPM` → `OD` → `KD` → `KD`

Set mute or unmute: `E0 158GRPM` → `OD` → `KD` → `KD`

**NOTE:**
- `x1` = Input number: `01` – `08`
- `x2` = Output number: `01` – `04`
- `x6` = HDCP status (for inputs): `0` = no source connected, `1` = source is HDCP compliant, `2` = source is not HDCP compliant
- `x8` = HDCP status (for outputs): `0` = No monitor connected, `1` = Monitor connected but does not support HDCP, `2` = Monitor connected, supports HDCP, but the video signal is not encrypted, `7` = Monitor connected, supports HDCP, and the video signal is encrypted
- `XH` = HDCP authorized device: `0` = on (default), `1` = off
- `x7` = Signal detection status: `0` = no input connected, `1` = input connected

### Notes

- The DTP CrossPoint 84 has 16 configurable group masters.
- By factory default, group 1 controls the program volume and group 2 controls the mic volume.
- Other group masters (such as mutes) must have been created in the DSP Configurator program to be available as `XIBs` for SIS commands.
<table>
<thead>
<tr>
<th>Command</th>
<th>SIS Command (Host to Unit)</th>
<th>Response (Unit to Host)</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recall a preset</td>
<td>$X_{13}$</td>
<td>$R_{p} X_{13}$</td>
<td>Recall preset $X_{13}$</td>
</tr>
<tr>
<td>View video and audio mutes</td>
<td>View output mutes</td>
<td>$E_{X} V_{M}$</td>
<td>$X_{13}$ $X_{13}$ $X_{13}$ $X_{13}$</td>
</tr>
<tr>
<td>Lock (Executive) modes</td>
<td>NOTE: See Setting the Front Panel Locks (Executive Modes) on page 17 for more information on the Lock modes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock all front panel functions</td>
<td>1X</td>
<td>$E_{x1} E_{x1}$</td>
<td>Enable Lock mode 1.</td>
</tr>
<tr>
<td>Lock advanced front panel functions</td>
<td>2X</td>
<td>$E_{x2} E_{x2}$</td>
<td>Enable Lock mode 2.</td>
</tr>
<tr>
<td>Unlock all front panel functions</td>
<td>0X</td>
<td>$E_{x0} E_{x0}$</td>
<td>Enable Lock mode 0.</td>
</tr>
<tr>
<td>View lock status</td>
<td>X</td>
<td>$X_{15}$</td>
<td></td>
</tr>
<tr>
<td>Information requests</td>
<td>Information request</td>
<td>I</td>
<td>$D_{T P C P 8 4}$</td>
</tr>
<tr>
<td>Request part number</td>
<td>N</td>
<td>60-nnnn-nn</td>
<td>See the Extron website for part number.</td>
</tr>
<tr>
<td>Query firmware version</td>
<td>Q</td>
<td>$X_{15}$</td>
<td>1.23</td>
</tr>
</tbody>
</table>

**NOTE:**

- $X_{13}$ = Preset 01 through 32
- $X_{14}$ = Video and audio mute status 0 = no mutes 2 = audio mute 1 = video mute 3 = video and audio mute 2 = lock mode 2 (default)
- $X_{15}$ = Lock mode 0 = lock mode 0 (unlocked) 1 = lock mode 1
- $X_{16}$ = Firmware version number to second decimal place (x.xx)

---

**Installing the Programs**

2. Click the Software link. Select the desired software to download and click Download.
3. Jump to the nearest page of downloads by clicking the desired filtering letter.

**NOTES:**
- Run either program from a PC connected to an Ethernet port on the IPCP control processor (item 1 on page 8), or USB port (item 1 on page 14) on the switcher.
- The DTP CrossPoint 84 User Guide is available on the Extron website, including Windows-based programs are available on the Extron website.
Installing and Starting the Control Programs

Several useful Windows-based programs are available on the Extron website, including the Digital Signal Processor (DSP) Configurator program, the Product Configuration Software (PCS), and the Firmware Loader program.

The Product Configuration Software configures the video functions of the switcher.

The DSP Configurator program is required for full operation of the DSP functions of the switchers and to save presets. It also provides some limited control of the non-DSP functions of the switcher. See the *DTP Crosspoint 84 User Guide* and the program Help file for more information.

Run either program from a PC connected to an Ethernet port on the IPCP control processor (item Q on page 8), serial port (item R on page 8), or USB port (item A on page 14) on the switcher.

NOTES:
- For details on operating the program, see the *DTP CrossPoint 84 Switcher User Guide*.
- The DSP Configurator program has a software switch that allows you to lock out audio adjustments in the Product Configurator Software, making them unavailable for selection.

Installing the programs

The DSP Configurator, version 2.6 or newer; PCS, version 2.0 or newer; and Firmware Loader are available on the Extron website. Download and install all programs as follows:

1. Visit [www.extron.com](http://www.extron.com) and click the **Download** tab.

![Download Center](image.png)

2. Click the **Software** link.

3. Select the desired software to download and click **Download**.

**TIP:** Jump to the nearest page of downloads by clicking the desired filtering letter.

![DSP Configurator](image.png)

The Download Center dialog box appears (see figure 12, on the next page).
4. Enter the requested personal information; 
   
   **TIP:** Click **Remember Me** to eliminate step 4 in future downloads.

5. Click **Download** to copy the software or firmware to your computer. The download warns you about downloads and asks you to confirm it.

6. Click **Run** to confirm that you want to run the installation.

7. Follow the on-screen instructions. The installation program creates the necessary directories and folders and installs the programs.

**Starting the Product Configuration Software**

1. Click **Start > Programs > Extron Electronics > Extron Product Configuration Software > Extron Product Configuration Software.**

   The Product Configuration Software opens to the Device Discovery screen.

2. **TIP:** You can also launch the Product Configuration Software from the DSP Configurator program, BUT PCS can be locked out from within DSP.

   Select (click) your DTP CrossPoint (1) and click **Connect** (2).

   **NOTE:** The default IP address is 192.168.254.254.

   The Product Configuration Software opens. Operate the program as described in the DTP CrossPoint 84 User Guide, available at [www.extron.com](http://www.extron.com), and the built-in Help file.
Starting the DSP Configurator Program

The DSP Configurator can connect to the switcher via any rear panel LAN port, the rear panel Remote (RS-232) port, or the front panel Configuration port. The program can operate at 9600, 19200, 38400, or 115200 baud rates for the Remote port.

NOTE: Extron recommends connection via an Ethernet LAN port for the DSP Configurator program.

Start the DSP Configurator program, as follows:

1. Click Start > Programs > Extron Electronics > DSP Configurator > DSP Configurator. The DSP Configurator startup screen displays (see figure 15).

   ![DSP Configurator Screen and Device Selection](image1.png)

   Figure 15. DSP Configurator Screen and Device Selection

   TIP: You can also launch the DSP Configurator program from within the Product Configuration Software.

2. If necessary, select the DTP CrossPoint switcher in the drop-down menu and click OK.

   TIP: If you have only DTP CrossPoint switchers of the same model, click Always perform the selected operation to eliminate step 2 in future startups.

   The DSP Configurator program starts in Emulate mode (see figure 16 on the next page).

   ![DSP Configurator](image2.png)

   Figure 16. DSP Configurator

NOTE: In Emulate mode, changes and settings are stored in the PC and not sent to the switcher until you select Live mode and ‘push’ the settings to the switcher. See the DTP CrossPoint 84 Switcher IPCP User Guide.
Accessing the HTML Pages

NOTES:

• If your Ethernet connection to the matrix switcher is unstable, try turning off the proxy server in your web browser. In Microsoft Internet Explorer, click Tools > Internet Options > Connections > LAN Settings, uncheck the Use a proxy server... box, and then click OK.

• For details on operating the switcher via HTML pages, see the “HTML Operation” section in the DTP CrossPoint 84 IPCP User Guide.

1. Start the web browser program.

NOTE: For best results, Extron recommends the following browsers and compatibility mode:
• Microsoft® Internet Explorer®, version 8.0 or newer, with compatibility mode off
• Mozilla® Firefox®, version 6 or newer
• Google® Chrome®, version 9 or newer
• Apple® Safari®, version 4 or newer

2. Click in the Address field and enter the IP address.

NOTE: 192.168.254.254 is the factory-specified default value for this field.

3. Press the keyboard <Enter> key. The switcher checks whether it is password-protected.

If the switcher is not password-protected, it checks and downloads the HTML start-up page. The switcher is ready for operation via HTML remote control.

If the switcher is password-protected, it downloads the Enter Network Password dialog box (see figure 17).

Figure 17. Network Password Dialog Box

NOTE: A User name entry is not required.

4. Enter the appropriate administrator or user password in the Password field and click OK.

The switcher downloads the HTML start-up page (see figure 18). The switcher is ready for operation via HTML remote control.

Figure 18. HTML Startup Page
Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty period, with proof of purchase and description of malfunction to:

**USA, Canada, South America, and Central America:**
Extron Electronics
1230 South Lewis Street
Anaheim, CA 92805
U.S.A.

**Europe and Africa:**
Extron Europe
Haneziboulevard 10
3825 PH Amersfoort
The Netherlands

**Asia:**
Extron Asia Pte Ltd
135 Joo Seng Road, #04-01
PM Industrial Bldg.
Singapore 369363
Singapore

**Japan:**
Extron Electronics, Japan
Kyodo Building, 16 Ichibancho
Chiyoda-ku, Tokyo 102-0082
Japan

**China:**
Extron China
686 Ronghua Road
Songjiang District
Shanghai 201611
China

**Middle East:**
Extron Middle East
Dubai Airport Free Zone
F12, PO Box 293666
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not authorized by Extron.

**NOTE:** If a product is defective, please call Extron and ask for an application engineer to receive an RA (return authorization) number. This will begin the repair process.

<table>
<thead>
<tr>
<th>Region</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>714.491.1500 or 800.633.9876</td>
</tr>
<tr>
<td>Europe</td>
<td>31.33.453.4040</td>
</tr>
<tr>
<td>Asia</td>
<td>65.6383.4400</td>
</tr>
<tr>
<td>Japan</td>
<td>81.3.3511.7655</td>
</tr>
</tbody>
</table>

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage during shipment. Returned units must include the serial number and a description of the problem, as well as the name of the person to contact in case there are any questions.

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may not apply to you.
<table>
<thead>
<tr>
<th>Location</th>
<th>Contact Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extron USA Headquarters</td>
<td>+800.633.9876 (Inside USA/Canada Only)</td>
</tr>
<tr>
<td>Extron USA - West</td>
<td>+1.714.491.1500</td>
</tr>
<tr>
<td></td>
<td>+1.714.491.1517 FAX</td>
</tr>
<tr>
<td>Extron USA - East</td>
<td>+1.919.850.1000</td>
</tr>
<tr>
<td></td>
<td>+1.919.850.1001 FAX</td>
</tr>
<tr>
<td>Extron Europe</td>
<td>+800.3987.6673 (Inside Europe Only)</td>
</tr>
<tr>
<td></td>
<td>+31.33.453.4040</td>
</tr>
<tr>
<td></td>
<td>+31.33.453.4050 FAX</td>
</tr>
<tr>
<td>Extron India</td>
<td>1800.3070.3777 (Inside India Only)</td>
</tr>
<tr>
<td></td>
<td>+91-80 3055 3777</td>
</tr>
<tr>
<td></td>
<td>+91 80 3055 3737 FAX</td>
</tr>
<tr>
<td>Extron Japan</td>
<td>+81.3.3511.7655</td>
</tr>
<tr>
<td></td>
<td>+81.3.3511.7656 FAX</td>
</tr>
<tr>
<td>Extron China</td>
<td>+4000.EXTRON</td>
</tr>
<tr>
<td></td>
<td>+4000.39876</td>
</tr>
<tr>
<td></td>
<td>Inside China Only</td>
</tr>
<tr>
<td>Extron Korea</td>
<td>+82.2.3444.1571</td>
</tr>
<tr>
<td></td>
<td>+82.2.3444.1575 FAX</td>
</tr>
<tr>
<td>Extron Middle East</td>
<td>+971.4.2991800</td>
</tr>
<tr>
<td></td>
<td>+971.4.2991880 FAX</td>
</tr>
<tr>
<td>Extron Asia</td>
<td>+800.7339.8766</td>
</tr>
<tr>
<td></td>
<td>Inside Asia Only</td>
</tr>
<tr>
<td></td>
<td>+85.6383.4400</td>
</tr>
<tr>
<td></td>
<td>+85.6383.4664 FAX</td>
</tr>
<tr>
<td>Extron Asia</td>
<td>+800.7339.8766</td>
</tr>
<tr>
<td></td>
<td>Inside Asia Only</td>
</tr>
<tr>
<td></td>
<td>+85.6383.4400</td>
</tr>
<tr>
<td></td>
<td>+85.6383.4664 FAX</td>
</tr>
</tbody>
</table>